FHWA GIS Safe Routes to School Tools
Version 4.0
User Guide

Prepared for
Federal Highway Administration
Office of Safety Research and Development
6300 Georgetown Pike, T-203
McLean, VA 22101-2296

By
Vanasse Hangen Brustlin, Inc.
101 Walnut St
P.O. Box 9151
Watertown, MA 02471-9151
Table of Contents

Introduction .................................................................................................................................1
Requirements ................................................................................................................................1
Installation ...................................................................................................................................1
  Microsoft .Net Framework v1.1/2.0 ........................................................................................1
  ArcGIS .Net Support .............................................................................................................1
  Application .............................................................................................................................1
  Support Libraries ................................................................................................................1
  Toolbar ....................................................................................................................................2
Execution ..................................................................................................................................2
Functionality ...............................................................................................................................3
  Display Layer ........................................................................................................................3
  Route Generator Tool ..........................................................................................................4
  Load Route Definition Tool ...............................................................................................6
  Directions ..............................................................................................................................6
Countermeasures Tools ...............................................................................................................7
  New CM Layer ......................................................................................................................8
  Open CM Layer ....................................................................................................................10
  Save CM Layer .....................................................................................................................10
  Edit CM Layer .....................................................................................................................11
  Apply Countermeasures ......................................................................................................11
  Reset Default Values ..........................................................................................................11
Generic Tools ...........................................................................................................................11
  Report ..................................................................................................................................11
  Map Template .....................................................................................................................12
  ADM Setup ..........................................................................................................................13
    Database Connection ..........................................................................................................13
Appendix A - New Project Setup and Database Configuration .......... 14
  Initialization .......................................................................................................................14
  Data Reference ....................................................................................................................14
    Feature Classes ................................................................................................................15
    Tables ................................................................................................................................15
    Layers ................................................................................................................................15
    Countermeasures .............................................................................................................15
    Traffic Calming Hazard Values ........................................................................................16
    Initialization Parameters .................................................................................................17
Appendix B – ADM Setup .................................................................................................... 18
  1 – ADM Setup ...................................................................................................................19
  2 – ADM Environment .......................................................................................................19
  3 – ADM SQL ......................................................................................................................19
  4 – ADM SDE .....................................................................................................................20
  5 – ADM Feature Class ......................................................................................................21
  6 – ADM Table ....................................................................................................................23
  7 – ADM Layer ...................................................................................................................25
  8 – ADM Layer Related .....................................................................................................26
Appendix C: Create a Street Network Dataset ...............................................................26
Appendix D: Create Address Locator .............................................................27
Introduction
This document provides basic Installation and Execution instructions for the FHWA GIS Safe Routes to School toolbar Version 4.0 ArcGIS v9.1 or greater.

Requirements
For this extension to work, at a minimum, the following software must be installed on the local computer:

- Microsoft .Net Framework (v1.1 or 2.0);
- ESRI ArcGIS 9.1 (sp2) or 9.2 – (both with .Net Support)
- ESRI Network Analyst Extension; and,
- Crystal Reports version XI for ESRI.

*Data Preparation…
It is required that the dataset created for the file have a Network Dataset created from it. See Appendix B: Creating Network Dataset…

It is also required that the Street centerline have a locator service created for it. Go to Appendix C: Creating a Locator Service…

Installation

Microsoft .Net Framework v1.1/2.0
The Microsoft .Net Framework is a software component which can be added to the Microsoft Windows operating system. It provides a large body of pre-coded solutions to common program requirements, and manages the execution of programs written specifically for the framework.

If necessary, the Microsoft .Net Framework redistributable package can be downloaded directly from the Microsoft website. Follow the instructions on this page on how to install the package.

ArcGIS .Net Support
In ArcGIS 9.1, .Net Support is not installed by default, so the user must select it as a custom installation option during install. If ArcGIS 9.1 is already installed and does not have .Net Support installed, run the ArcView Setup, select 'Modify' the installation and then select '.Net Support'.

In ArcGIS 9.2, the .Net Support option is installed by default providing the ArcGIS installation is performed on a machine with .Net Framework 2.0 installed.

Application
To install the FHWA GIS Safe Routes to School Toolbar:

Support Libraries
1. Download the installation package ‘vhblibraries.msi’ from the FHWA website.
2. Double-click the ‘vhblibraries.msi’ installation package. An installation wizard will start to perform the installation. Follow the instructions. Several support library files will be installed in to [Program Files]\VHB\Common (i.e., C:\Program Files\VHB\Common).
Toolbar
1. Download the installation package ‘setupSRS.msi’ from the FHWA website.
2. Double-click the ‘setupSRS.msi’ installation package to install the main application toolbar and project components. An installation wizard will start to perform the installation. Follow the instructions.

Several files will be installed in the application destination directory (i.e., c:\Program Files\FHWA\SRS):

1. SRSADM.mdb. A blank application database. The database can be copied and modified to reference project-specific data.
2. SRS.mxt. A pre-defined Map template.
4. ADM v2 Data Dictionary.

The main application file (FHWASRS.dll) is installed in the Common files folder (i.e., c:\Program Files\VHB\Common).

Execution
To open ArcGIS with the FHWA GIS Safe Routes to School toolbar, either:

1. Open ArcMap.
2. Select ‘File → Open…’. Using the File Dialog, select the ArcGIS Project (i.e., ‘c:\SRS\SRS.mxd’).
3. ArcGIS should open and load the Project.

Or:

1. Navigate to the appropriate Project folder (i.e., ‘c:\SRS’).
2. Double-click the ArcGIS Project (i.e., ‘c:\SRS\SRS.mxd’).
3. ArcGIS should open and load the Project.
**Functionality**

The following functionality was implemented as part of the Safe Routes to School Tools application v4.0.

**Display Layer**

This tool allows any of the Layers or Tables defined within the ADM Database to be opened and inserted into the current ArcGIS Project.

1. Click the ‘Display Layer’ tool on the ‘FHWA SRS Analysis’ toolbar.
2. A Dialog is displayed showing all of the defined Layers and Tables in a Tree View.
3. Select the Layer/Table to open and press the ‘Add’ button. The selected Layer/Table will be opened and inserted into ArcMap.
4. Repeat step 3 until all of the required Layers/Tables have been opened.
5. To exit from the Dialog, press ‘Close’.
Route Generator Tool

The process of generating (solving) a route involves the selections of stops along the route as well as setting any barriers to avoid. The following dialog represents the main form which enables the configuration and generation of the route.

To configure and generate a Route, the following steps need to occur:

1. Select the type of Route to generate, either Shortest, Safest or Preferred Route:
   - Shortest Route: Solves the shortest Route based on the minimizing distance through the network.
   - Safest Route: Solves the safest route. The cost for each segment is based on the SafeImpedence cost attribute in the Streets Network Dataset. See Appendix
   - Preferred Route: Solves the user’s preferred route based on the selection of weighted factors. Road Conditions, Vehicle Volume, Vehicle Speed and Length can be weighted on a scale or 0-10, with 0 being no preference and 10 being high preference.
2. Add Stops along the route:

   a. Select the Add Stop button (red pushpin), and place the stop locations along the route on the map. Each stop will be displayed on the map and in the Stops list on the form in the order it was placed on the map. Stops can be reordered using the arrows to the right of the list and can be removed using the Remove button (indicated by the yellow X).
   
   b. Add Address: to add a specific address, you can use the ‘Add Address’ button.

   **Note:** Only valid addresses will be accepted. Street Names (i.e. Macon) must match to the letter but don’t need to be case sensitive. The type of street can be represented by the full word (Place) or the abbreviation (Pl) and is required where there is such a designation. Directions are also required, in either format (South or S).

3. If it is desired that the current configuration be saved, click the ‘Save’ button. This will save the route definition to an XML file representing the configuration parameters which can be loaded again at a later time.

4. To reset (clear) the form, click the ‘Reset’ button. This will reset all of the form elements to their original state and clear and points from the map.

5. Once you are ready to generate a Route, click the ‘OK’ button. This will generate (solve) the route on the map and will be visible in the TOC window.
**Load Route Definition Tool**

A saved route definition file can be loaded into the system. To do this, click on the Load Saved Route Definition Tool. The following dialog will appear:

![Open Route Definition File Dialog](image)

Click ‘Open’ once the file is selected. Once the route definition file has been loaded, the Route Generator dialog will open with the route configuration parameters from the loaded .rdf file.

**Directions**

Click on the Directions tool to call up the Directions window. The Directions tool becomes activated when the root Route Layer (i.e. ‘Route 1’) is highlighted in the table of contents. The Directions window appears as follows:
The following actions are available from the Directions window:

- **Options**: Enables changing the distance units and output settings.
- **Print Preview**: Preview the directions as they will be sent to the printer
- **Save As**: Ability to save directions as text or HTML
- **Print**: Calls up the Print dialog to print the directions
- **Close**: Closes the window.

## Countermeasures Tools

Countermeasures tools provide the ability to assign Countermeasures to individual street segments and crossings to adjust the route analysis. The Countermeasure Tools menu appears as follows, enabling the user to create, open, save or edit a Countermeasure layer. Also available are tools to apply the countermeasure and reset default values in the Streets layer.
New CM Layer

Selecting the 'New CM Layer' tool will create a new Countermeasure layer. If a group layer for Countermeasures has not been created, one will be created to contain all Countermeasure layers created during the session.

**Note:** This layer will be created in a temporary system folder that will get cleaned out when the temp resources are deleted from the machine. If it desired that a Countermeasure layer be saved for future use, the ‘Save CM Layer’ tool to save the Countermeasure to a permanent location.

Once the layer is created, the Countermeasures dialog will be displayed. This dialog appears as follows:

To create a new Countermeasure in the Countermeasure Layer, the following must occur:
1. Use the selection tool provided in the Countermeasures dialog, or use ArcMap’s native selection tools to select one or more street segments or street crossings for which to apply a Countermeasure to.

2. Select the Countermeasures to create in the dialog by marking a check next to each Countermeasure to create.

3. Once the Street segments and crossing are selected in the map and Countermeasures selected in the Countermeasures Dialog, click ‘OK’ to add them to the Countermeasures layer. If Traffic Calming is selected, speed reductions will first need to be assigned*.

*When Traffic Calming is selected, speed reductions need to be assigned for each selected Street segment. The following dialog is opened automatically when the Traffic Calming option is selected:

![Traffic Calming dialog]

To set the traffic calming speed reductions, either update the Spd (New) value for each Street, or enter a value in the ‘Reduce All By’ box to reduce the speed for all streets.

**About Countermeasures**

Countermeasures are applied as follows:

<table>
<thead>
<tr>
<th>Countermeasure</th>
<th>Applies to</th>
<th>Hazard Reduction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adult Crossing Guard</td>
<td>Street Crossing</td>
<td>1.4 (two way) 1.0 (one way)</td>
</tr>
<tr>
<td>Traffic Calming</td>
<td>Street</td>
<td>varies with speed</td>
</tr>
<tr>
<td>Prohibit Parking</td>
<td>Street</td>
<td>0.6</td>
</tr>
<tr>
<td>Road Signs</td>
<td>Street</td>
<td>0.5</td>
</tr>
<tr>
<td>Separate walking paths</td>
<td>Street</td>
<td>0.0*</td>
</tr>
<tr>
<td></td>
<td></td>
<td>*(Actual value assigned)</td>
</tr>
<tr>
<td>Sidewalk</td>
<td>Street</td>
<td>3.4</td>
</tr>
<tr>
<td>Pedestrian Signal</td>
<td>Street Crossing</td>
<td>1.4</td>
</tr>
<tr>
<td>STOP Sign</td>
<td>Street</td>
<td>1.6</td>
</tr>
<tr>
<td>Reducing peak hour ADT by 20%</td>
<td>Street</td>
<td>0.1</td>
</tr>
</tbody>
</table>

*This information is stored in the Countermeasures table in the configuration (ADM) database. More information on this table is available in Appendix A: New Project Setup and Database configuration.

**About Countermeasure Layer Classification**

The classification scheme for the Countermeasures layer is defined by the layer (.lyr) file which is contained in the project ‘lyr’ folder. The legend classification scheme appears as follows:
To make changes to the classifications, right click on the Countermeasures layer and select ‘Properties’. Make desired changes to the symbology and TOC label as needed. *Do not change any of the Countermeasure names as these are tied to the system.

Once the Layer Properties have been updated, right click the Countermeasure layer again and select ‘Save As Layer File’. Choose the following path: [Project folder]\lyr and overwrite the existing ‘countermeasure.lyr’ file.

**Open CM Layer**

Selecting the 'Open CM Layer' tool will provide the user the ability to open a saved Countermeasure layer. After selecting the Countermeasure shape file, the Countermeasure layer is loaded into the map. To edit the Countermeasures, select the Countermeasure layer in the TOC and select ‘Edit CM Layer’.

**Save CM Layer**

The ‘Save CM Layer’ tool is only enabled when a Countermeasure layer is selected in the TOC. Selecting ‘Save CM Layer’ while a Countermeasure layer is selected will open a file dialog, enabling the user to save a permanent copy of the Countermeasure shape file that drives the Countermeasure layer.
Type a memorable name so that the Countermeasures can be easily incorporated again at a later date. The saved Countermeasure can be accessed again using the ‘Open CM Layer’ tool.

**Edit CM Layer**

The ‘Edit CM Layer’ tool is only enabled when a Countermeasure layer is selected in the TOC. Selecting ‘Edit CM Layer’ while a Countermeasure layer is selected will open the Countermeasure dialog allowing the user to continue to make modification. See a description of the Countermeasures dialog in ‘New CM’.

**Note:** To delete a Countermeasure layer from the map, simply right click on the Countermeasure layer in the TOC and select ‘Remove’.

**Apply Countermeasures**

The ‘Apply Countermeasures’ tool incorporates Countermeasures from the selected Countermeasure layer in to the Streets centerline dataset. The ‘Apply Countermeasures’ tool is only enabled when a Countermeasure layer is selected in the TOC.

Once the Countermeasure is applied, a Route analysis can be generated again to see the effects of the Countermeasures on the construction of the route.

**Reset Default Values**

This tool resets the default impedance values in the Streets layer. Any adjustments made by the application of Countermeasures will be lost as soon as the ‘Reset Default Values’ tool is executed.

**Generic Tools**

**Report**

Custom reports can be generated using the Crystal Reports engine bundled with ArcGIS.
1. Select (highlight) the single Layer (not a Group Layer) in the Table of Contents from which the report is to be generated.


3. A Dialog is displayed allowing the parameters of the Report to be set:
   b. Map Template – If a Map is to be included in the Report, this parameter allows the user to select the Map Template (.mxt)
   c. Values – Additional values that can be included within the Report.

   ![Report Template Setup](image)

   Once all of the parameters are entered, press OK.

4. The Report is then generated and displayed in a new window. From this new window the report can be viewed, exported to a variety or formats or printed.

**Note:** When a new report template is selected, the Toolbar checks to see if a Map image is included within the Report. If so, the ‘Map Template’ edit line is activated.

**Note:** The use of this tool does not preclude the use of the native ArcMap report tools that utilize Crystal Reports. Please refer to the ArcGIS Desktop Help for more information on how to use the native Reporting tools.

**Map Template**

Custom maps can be generated using the predefined Map Templates.

1. Click the ‘Map Template’ command on the ‘FHWA SRS Analysis’ toolbar ‘Tools’ menu.

2. A Dialog is displayed allowing the parameters of the Map to be set:
   a. Printer – The printer on which the Map is to be produced.
   b. Map Template – Allows the user to select the Map Template (.mxt)
   c. Values – Additional values that can be included within the Map.
Once all of the parameters are entered, press OK.

3. The Map is then generated and displayed.

**ADM Setup**

Manages the ADM Database. To access the ADM Setup tool:


For specific information about using this tool, refer to ‘Appendix B – ADM Setup’.

**Database Connection**

Change the Connection to the active Database.

1. Click the ‘Database Connection’ command on the ‘FHWA SRS Analysis’ toolbar ‘Tools’ menu.
2. The ‘Database Connection’ dialog will be displayed:

3. Either type in the Path and Name of the ADM database (i.e., ‘c:\VHB\MyProj\adm.mdb’) or use the Browse button.
4. Once selected, press the ‘OK’ button.
Appendix A - New Project Setup and Database Configuration

To provide a high level of configurability, the FHWA Safe Routes to School application uses the ArcGIS Data Manager (ADM) to manage all of the data used within the application. The ADM consists of a number of related tables stored within a Microsoft Access database. These tables define all of the Feature Classes, Tables, Layers and related data accessible by the FHWA Safe Routes to School application. For a detailed description of the ADM, refer to the document 'ArcGIS Data Manager Version 2.0 Data Dictionary'.

There are also two tables which are used in with the Countermeasures component of the application: Countermeasures and Traffic Calming Hazard Values. These are described in this section.

Note: It is assumed that the user setting up the new Project ADM database is familiar with ArcGIS and how to load, join, linear reference and classify data.

Initialization

To initialize the database for a new Project:

1. Create a new Project directory (i.e., ‘c:\SRS’).
2. Copy the ADM database ‘SRSADM.mdb’ and the Map template (‘SRS.mxt’) from the application installation directory (i.e., ‘c:\Program Files\FHWA’) to the new Project directory.
3. Open ArcGIS.
4. The FHWA SRS Analysis toolbar should load automatically. If not, select ‘View → Toolbars → FHWA SRS Analysis.’
5. Save the blank ArcGIS Project into the Project directory (i.e., ‘c:\SRS\SRS.mxd’).
6. Select the ‘Tools → Database Connection’ menu option on the ‘FHWA SRS Analysis’ toolbar. The ‘Database Connection’ dialog will be displayed:

   ![Database Connection Image]

   7. Either type in the Path and Name of the ADM database (i.e., ‘c:\SRS\SRSADM.mdb’) or use the Browse button. Once selected, press the ‘OK’ button.
8. Resave the updated ArcGIS Project into the project directory (i.e., ‘c:\SRS\SRSADM.mxd’).

Data Reference

For the FHWA Safe Routes to School application to function properly, the Streets Layer needs to be correctly defined, while other Layers are optional but provide background and reference in the map. These Layers are defined within the ADM database and are based upon defined Feature Classes and Attribute Tables.

Note: For examples on referencing the Feature Classes, Tables and Layers, refer to the ADM database contained with any of the example datasets.
Feature Classes
The FHWA Safe Routes to School application requires four Feature Class references to be setup within the ‘ADMFeatureClass’ Table in the ADM database.

<table>
<thead>
<tr>
<th>Tag</th>
<th>Feature Class Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Streets</td>
<td>Polyline</td>
<td>Used to display the Streets used in Route system</td>
</tr>
<tr>
<td>Schools</td>
<td>Points</td>
<td>Schools located in the study area</td>
</tr>
<tr>
<td>CounterMeasures</td>
<td>Polyline</td>
<td>Feature Class representing the Countermeasures</td>
</tr>
<tr>
<td>StudyArea</td>
<td>Raster</td>
<td>Raster Image</td>
</tr>
</tbody>
</table>

These references can be entered either manually by opening the ADM database in Microsoft Access and editing the ‘ADMFeatureClass’ Table, or using the ‘ADM Setup’ functionality (see ‘Appendix B – ADM Setup’, ‘5 – ADM Feature Class’).

Tables
The FHWA Safe Routes to School application doesn’t require any tables to be configured in the ADM database. If it is desired that tables be made available through this interface, please refer to the ‘ArcGIS Data Manager Version 2.0 Data Dictionary’

Layers
The FHWA Safe Routes to School application requires eleven Layer references to be setup within the ‘ADMLayer’ Table in the ADM database.

<table>
<thead>
<tr>
<th>Tag</th>
<th>Feature Class Based on</th>
<th>Key Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Streets</td>
<td>Streets</td>
<td>FID</td>
<td>(Required) Streets layer required for generating routes and selecting countermeasures</td>
</tr>
<tr>
<td>Schools</td>
<td>Schools</td>
<td>FID</td>
<td>Schools in the study area</td>
</tr>
<tr>
<td>StudyArea</td>
<td>StudyArea</td>
<td>FID</td>
<td>Image background layer of the study area</td>
</tr>
<tr>
<td>CounterMeasures</td>
<td>CounterMeasures</td>
<td>FID</td>
<td>(Required) Defines the Countermeasures layer</td>
</tr>
</tbody>
</table>

These references can be entered either manually by opening the ADM database in Microsoft Access and editing the ‘ADMFeatureClass’ Table, or using the ‘ADM Setup’ functionality (see ‘Appendix B – ADM Setup’, ‘7 – ADM Layer’).

Countermeasures
The FHWA Safe Routes to School application requires a record for each countermeasure used in the application.

<table>
<thead>
<tr>
<th>CMID</th>
<th>CMType</th>
<th>CName</th>
<th>CValue</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Crossing</td>
<td>Crossing Guard: 1 Way</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>Crossing</td>
<td>Crossing Guard: 2 Way</td>
<td>1.4</td>
</tr>
<tr>
<td>3</td>
<td>Street</td>
<td>Prohibit Parking</td>
<td>0.6</td>
</tr>
<tr>
<td>4</td>
<td>Street</td>
<td>Road Signs</td>
<td>0.5</td>
</tr>
<tr>
<td>5</td>
<td>Street</td>
<td>Sidewalk</td>
<td>3.4</td>
</tr>
<tr>
<td>6</td>
<td>Crossing</td>
<td>Pedestrian Signal</td>
<td>1.4</td>
</tr>
<tr>
<td>7</td>
<td>Crossing</td>
<td>Marked Crosswalk</td>
<td>1.2</td>
</tr>
<tr>
<td>8</td>
<td>Street</td>
<td>Reduce Peak ADP (20%)</td>
<td>0.1</td>
</tr>
<tr>
<td>9</td>
<td>Street</td>
<td>Traffic Calming</td>
<td>0</td>
</tr>
<tr>
<td>10</td>
<td>Street</td>
<td>Stop Sign</td>
<td>1.6</td>
</tr>
<tr>
<td>11</td>
<td>Street</td>
<td>Separate Path</td>
<td>0</td>
</tr>
</tbody>
</table>
Note: While it is possible to update any value in this table, edits should only be made to the CM Value field. Editing the CMType or CMName fields could compromise the system.

Traffic Calming Hazard Values
The ‘CMSpeedTravelLaneHazard’ table contains speed factor values to be used in the event that a Traffic Calming countermeasure is applied.

<table>
<thead>
<tr>
<th>SpeedName</th>
<th>MinSpeed</th>
<th>MaxSpeed</th>
<th>FT_F</th>
<th>TF_F</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-15 miles/hour</td>
<td>0</td>
<td>15</td>
<td>1.4</td>
<td>1.4</td>
</tr>
<tr>
<td>16-25 miles/hour</td>
<td>16</td>
<td>25</td>
<td>1.8</td>
<td>1.8</td>
</tr>
<tr>
<td>26-35 miles/hour</td>
<td>26</td>
<td>35</td>
<td>2.6</td>
<td>2.6</td>
</tr>
<tr>
<td>36-45 miles/hour</td>
<td>36</td>
<td>45</td>
<td>3.2</td>
<td>3.2</td>
</tr>
<tr>
<td>46-55 miles/hour</td>
<td>46</td>
<td>55</td>
<td>4</td>
<td>4</td>
</tr>
</tbody>
</table>
Initialization Parameters

To allow the FHWA Safe Routes to School application to ‘understand’ the data that it is accessing, several initialization parameters need to be set in the ‘ADMSetup’ table.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Example Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client</td>
<td>Client name</td>
<td>VHB</td>
</tr>
<tr>
<td>Version</td>
<td>ADM Version (Required)</td>
<td>2.0</td>
</tr>
<tr>
<td>Network Datasets Path</td>
<td>The path to the Streets Network Dataset (Required)</td>
<td>$PROJ\data</td>
</tr>
<tr>
<td>Streets Network Dataset Name</td>
<td>The name of the Streets Network Dataset (Required)</td>
<td>Streets_ND</td>
</tr>
<tr>
<td>Streets Locator Path</td>
<td>The path to the Streets Locator file (Required)</td>
<td>$PROJ\data</td>
</tr>
<tr>
<td>SnapToleranceStops</td>
<td>The snap tolerance (in meters) for Stops (Required)</td>
<td>100</td>
</tr>
<tr>
<td>SnapToleranceAvoids</td>
<td>The snap tolerance (in meters) for Avoids (barriers) (Required)</td>
<td>100</td>
</tr>
<tr>
<td>Primary Streets Layer Tag (ADM)</td>
<td>The name of the primary Streets dataset (Required)</td>
<td>Streets</td>
</tr>
<tr>
<td>Output Folder</td>
<td>The name and path of the Output location to store Analysis Shape files (Required). Note: Note: $PROJ\ indicates the path of the parent .mxd file.</td>
<td>$PROJ\Output</td>
</tr>
<tr>
<td>Countermeasure Folder</td>
<td>The name of the Countermeasure folder to store Saved Countermeasures (Required)</td>
<td>$PROJ\CM</td>
</tr>
<tr>
<td>CMGroupLayerName</td>
<td>The name of the Countermeasure Group Layer to use in ArcMap (Required)</td>
<td>Counter Measures</td>
</tr>
<tr>
<td>CMFClassTagName(ADM)</td>
<td>The name of the Countermeasure FClass in ADM (Required)</td>
<td>CounterMeasures</td>
</tr>
<tr>
<td>StreetIDFieldName</td>
<td>The unique ID field to use for Streets (Required)</td>
<td>FID</td>
</tr>
<tr>
<td>StreetNameFieldName</td>
<td>The single name field to use for Streets (Required)</td>
<td>STNAME</td>
</tr>
<tr>
<td>StreetFTCostValue</td>
<td>The field in the Streets dataset that indicates the From-To Impedance cost (Required)</td>
<td>FT_CMCOST</td>
</tr>
<tr>
<td>StreetTFCostValue</td>
<td>The field in the Streets dataset that indicates the To-From Impedance cost (Required)</td>
<td>TF_CMCOST</td>
</tr>
<tr>
<td>StreetTypeFieldName</td>
<td>The field in the Streets dataset that indicates whether the Street segment is a Crossing or not (Required)</td>
<td>Crossing</td>
</tr>
<tr>
<td>StreetSpeedLimitFieldName</td>
<td>The field in the Streets dataset that stores the speed limit for the segment (Required)</td>
<td>SPEED_LIMI</td>
</tr>
<tr>
<td>Route Defs Folder</td>
<td>The folder that contains Route Definitions (Required)</td>
<td>$PROJ\RouteDefs</td>
</tr>
</tbody>
</table>

These references can be entered either manually by opening the ADM database in Microsoft Access and editing the ‘ADMSetup’ Table, or using the ‘ADM Setup’ functionality (see ‘Appendix B – ADM Setup’, ‘1 – ADM Setup’).
Appendix B – ADM Setup
The ADM (ArcView Data Manager) Setup Tool provides a way to manage the ADM database that contains references about all data used in the project. The database is broken out into eight Elements:

1. ADM Setup – Initialization parameters.
2. ADM Environment – Environment variables.
3. ADM SQL – SQL database connections.
4. ADM SDE – ArcSDE database connections.
5. ADM Feature Class – Spatial data
6. ADM Table – Attribute data.
7. ADM Layer – Map Layers.
8. ADM Layer Related – Many-to-one data relationships.

All ADM maintenance events are initiated from the main ADM Setup Dialog.

- Add – Adds a new reference to the selected ADM Element.
- Edit – Edit the selected ADM Element reference.
- Delete – Removes the selected ADM Element reference from the ADM database.
1 – ADM Setup

The ADM Setup dialog provides the ability to set a Parameter and its corresponding Setting.

- Parameter – The name of the Parameter.
- Setting – The value that corresponds to the Parameter.

Note: To maintain system stability, the two Parameters ‘Client’ and ‘Version’ cannot be edited.

2 – ADM Environment

The ADM Environment dialog provides the ability to set a dynamic path Variable and its corresponding Value.

- Variable – The name of the Variable. Note: It is required that this name begin with a dollar sign (‘$’) and contain no spaces.
- Value – The directory path that the Variable corresponds to.

Note: The ‘$PROJ’ variable cannot be edited since it is related to the path of current ArcMap Project file and is dynamically set.

3 – ADM SQL

The ADM SQL dialog provides the ability to set the SQL Connection properties.

- Tag – This is used for reference purposes and must be unique.
- Type – The type of SQL Connection.
- DB Path – The path to the MS Access database if Type = ‘MS Access’.
- Connection String – The actual ADO Connection String that is used to connect to the database.
  - If Type ‘MS Access’ is selected, the Connection String is created automatically and not editable.
  - For other Types, the Connection String must be modified to establish the connection.
Click ‘Test’ to test the SQL connection with the current settings. Click ‘OK’ to save the SQL connection properties to the ADM database.

**4 – ADM SDE**

The ADM SDE dialog provides the ability to set the SDE Server Connection Properties. All fields are required.

- **Tag** – Used for reference purposes. Must be unique.
- **Server** – The name of the ArcSDE Server to connect to.
- **Version** – The Version of the database to connect to. In most cases this will be ‘sde.default’
- **Instance** – The Instance number to use for the connection.
- **User** – A valid user name that has access to the SDE Server instance.
- **Password** – A valid password that corresponds to the User name.

Click ‘Test’ to test the connection with the current settings and indicates whether the test was successful. Click ‘OK’ to save the connection properties to the ADM database.
5 – ADM Feature Class
The ADM Feature Class Dialog provides the ability to define all of the Spatial data (Feature Classes) that can be accessed by the Project.

Note: Depending upon the type of the Feature Class that has been selected, the actual required and optional data fields will vary.

- Tag – Used for reference purposes. Must be unique.
- Module – The Module with which to associate the ADM Feature Class.
- Data Type – The type of the ArcGIS Workspace that contains the Feature Class.
- Shapefile – (ArcInfo, dBase, File, Raster, SDC & Shapefile Only) Path and Name of the appropriate file.
- Connection – (SQL Only) Name of the defined ADM SQL Connection.
- SQL Select – (SQL Only) Select portion of the SQL statement that defines which fields to retrieve.
- SQL From – (SQL Only) The Table or View from which the data is retrieved.
- SQL Where – (SQL Only) (Optional) The Where Clause that defines the filter for the data.
- SQL Group By – (SQL Only) (Optional) Name(s) of the field(s) by which the data should be grouped.
- SDE Connection – (SDE Only) Name of the defined ADM SDE Connection.
- SDE Data Source – (SDE Only) Name of the Feature Class available via the selected SDE Connection.
- X Coord Field – (dBase, File or SQL) The field in the dataset that defines the X Coordinate.
- Y Coord Field – (dBase, File or SQL) The field in the dataset that defines the Y Coordinate.
- Coordinate System – (Optional) The Coordinate System of the data.
- Key Field – (Not Raster) (Optional) The name of the unique field to use as the key for each Feature in the Feature Class.
- Name Field – (Not Raster) (Optional) The name of the field to use as the name for each Feature in the Feature Class.
- Comments – (Optional) Any additional information to record about the ADM Feature Class.
- Active – Is the ADM Feature Class active?
- Required – Is this ADM Feature Class required for the Project to function correctly?
If a file based Feature Class (i.e., ArcInfo, dBase, File, Raster, SDC, Shapefile) is selected, a Dialog similar to the one below will be displayed.
If an SQL Data Type is selected, the following Dialog will be displayed.

![ADM Feature Class Dialog](image)

**Note:** To retrieve and refresh the available fields for the X and Y Coordinates and Key/Name Fields, click the ‘Test’ button.

Click ‘Test’ to ensure that the Feature Class can be successfully retrieved. Click ‘OK’ to save the Feature Class reference to the ADM database.

### 6 – ADM Table

The ADM Table dialog provides an interface for setting up table based data sources.

- **Tag** – Used for reference purposes. Must be unique.
- **Module** – The Module with which the ADM Table is associated.
- **Data Type** – The type of the ArcGIS Workspace that contains the Table.
- **Data Type** – The type of ADM Table. The following Types exist:
  - **Attribute** – A simple standalone table.
  - **Join** – The table is joined to a define ADM Feature Class.
  - **Point Event** – A table containing Point Events, linearly referenced against a Route System.
  - **Linear Event** – A table containing Linear Events, linearly referenced against a Route System.
- **Connection** – (SQL Only) Name of the defined ADM SQL Connection.
- SQL Select – (SQL Only) Select portion of the SQL statement that defines the fields to retrieve.
- SQL From – (SQL Only) The Table or View from which the data is retrieved.
- SQL Where – (SQL Only) (Optional) The Where Clause that defines the filter for the data.
- SQL Group By – (SQL Only) (Optional) Name(s) of the field(s) by which the data should be grouped.
- Key Field – (Optional) The name of the field to use as the key for each Table record.
- Name Field – (Optional) The name of the field to use as the name for each Table record.
- Comments – (Optional) Any additional information to record about the ADM Table.
- Active – Is the ADM Table active?
- Required – Is this ADM Table required for the Project to function correctly?

![Edit ADM Table](image)

**Note:** To retrieve and refresh the available fields for the X and Y Coordinates and Key/Name Fields, click the ‘Test’ button.

Click ‘Test’ to ensure that the Table can be successfully retrieved. Click ‘OK’ to save the Table reference to the ADM database.
7 – ADM Layer
The ADM Layer Dialog provides the ability to define all of the Layers that will be accessible by the Project.

- Tag – Used for reference purposes. Must be unique.
- Module – The Module with which associate the ADM Layer.
- ADM Feature Class – The ADM Feature Class upon which the Layer is based.
- Folder Name – The name of the folder (grouping) for the Layer when displayed in the ‘Display Layer’ Dialog.
- Name – The name of the Layer.
- Key Field – (Optional) The name of the field to use as the unique key for each Feature.
- Name Field – (Optional) The name of the field to use as the name for each Feature.
- Layer File – (Optional) Path and Name of the ArcMap Layer file (.lyr) used to classify the Features.
- Comments – (Optional) – Any additional information to record about the ADM Layer.
- Real – Does the ADM Layer reference refer to an existing Feature Class?
- Visible – Is the Layer visible on the Map when the Layer is displayed?
- Legend Visible – Is the Layer Legend visible in the Table of Contents when it is displayed?
- Startup TOC – Is the Layer Legend visible/active?

Click ‘Test’ to ensure that the data source can be successfully retrieved and that the Layer can be successfully formed and rendered in ArcMap.
Click ‘OK’ to save a reference to the ADM Layer to the ADM database.
8 – ADM Layer Related
ADM Layers can be related to any ADM Table by using this interface. Simply select the ADM Layer and the Table to join to and the fields to join. The relationship can be further extended by adding a Lookup table which can be joined to the parent Layer Related relationship.

- Layer – The ADM Layer.
- Layer Relate Field – The Field Name in the Layer that is used for the join.
- Table – The ADM Table to join.
- Table Relate Field – The name of the field in the Table that is used in the join.
- Lookup Table – (Optional) Name of the table that is used as a Lookup, if any,
- Lookup Layer Field – (Optional) The Field Name in the Layer Related that is used for the join.
- Lookup Table Field – (Optional) The name of the field in the Lookup Table that is used in the join.

Click ‘Test’ to ensure that both data sources can be successfully retrieved and that they can be joined using the selected fields.
Click ‘OK’ to save a reference to the ADM Layer Related record to the ADM database.

Appendix C: Create a Street Network Dataset
The Network Dataset must be created to represent the Streets network on which analysis will be performed. The basic process for creating a Network Dataset to be used with the SBR tool will be demonstrated below, but it is assumed that the user will have some knowledge about Network Datasets and network analysis methodologies. ArcGIS desktop Help can provide a good primer on the Network Dataset and what goes into creating it.

ArcCatalog will be utilized for the purpose of creating the Network Dataset. The following instructions highlight the minimum configuration options needed to use the SBR tool:

1. Navigate to the primary Streets network data, right click and select New Network Dataset.
2. Enter name (i.e. Streets_ND);
3. Click through the next three dialogs, using the default connectivity and turns options; 
4. Specify the attributes of the network. Enter three new Attributes.
   a. SafeImpedance: Cost. Set the Evaluator to be the corresponding cost measure field in the Streets dataset. Usually there should be a From and To cost. See Appendix E: Required fields in Street dataset to understand the required dataset.
   b. Length: Cost. Make sure to set the units – this is required to produce directions.
   c. Barriers: Restriction

After these are created, the attributes dialog should appear as follows:

      5. Click Next and then select Yes to establish driving directions settings. Use the default configuration options unless customized direction output is required.
6. Click Next then click Finish to create the Network Dataset.
7. Select Yes to build the Network Dataset. At any point if the values in the Streets dataset change, the Network Dataset will need to be rebuilt.

**Note:**
Make sure the reference path for this Network Dataset is entered correctly in the ADM Setup table for the Parameter “Network Datasets Path”.

If further advanced Network Analysis is required from the Network Dataset, please refer to the ArcGIS Desktop Help for further instructions.

**Appendix D: Create Address Locator**
In order for the SBR tool to locate an address along a route, an Address Locator must be created on the primary Streets dataset. The address locator is the main tool for geocoding in ArcGIS. It is a file that points to a number of other resources; these resources include the reference data as well as the geocoding engine and geocoding rule base. The Create Address Locator tool is contained in the Geocoding Tools category of ArcToolbox, accessible through ArcMap or ArcCatalog.

The steps for configuring the Address Locator are as follows:
1) Select the Address Locator Style;  
2) Select the Reference Data (i.e. Streets);  
3) Create the field mappings; and,  
4) Select the output path for the file.

The preceding steps are illustrated in the following snapshot of the Create Address Locator tool:

![Create Address Locator tool screenshot]

A common method for setting up an Address Locator is to use US Streets Style where the Low Left (LL), High Left (LH), Low Right (RL) and High Right (RH) House Numbers are established. Select a Street Name and make sure the other field mappings are correct. The Demo dataset for the SBR tool has this configuration.

**Note:**  
Make sure the reference path for this Network Dataset is entered correctly in the ADM Setup table for the Parameter “Network Datasets Path”.

---

Vanasse Hangen Brustlin, Inc.
Appendix E: Streets Dataset – Required Data

In order for the various functions and calculations to work according to the equations set out in the impedance methodology section, the following fields are required in the Streets dataset and must be populated accordingly. The following fields are required:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LENGTH</td>
<td>The length of the link (one-half of the adjacent T-intersection crossing width is added, if there is one)</td>
</tr>
<tr>
<td>F_CON_WITH</td>
<td>The hazard rating associated with walking conditions. It is expressed on a scale of 1 to 5, where 1 is the least hazardous and 5 is the most hazardous. The rating depends on whether sidewalks, shoulders, and on-street parking are present. F CONDITIONS is the hazard associated with a particular combination of sidewalks, shoulders, and on-street parking (f_sw, f_sh, and f_p). The ratings for walking with traffic are higher than the ratings for walking against traffic. (See the Appendix F sections on &quot;Impedance&quot;)</td>
</tr>
<tr>
<td>F_CON_AGNT</td>
<td>Same as F_CON_WITH</td>
</tr>
<tr>
<td>F_VOL_LOG</td>
<td>This is the common logarithm of the peak 15-minute volume (one-fourth of the peak hour volume).</td>
</tr>
<tr>
<td>F_SPEED</td>
<td>The measured or estimated 85th percentile speed, in miles / hour.</td>
</tr>
<tr>
<td>F_DRIVEWAY</td>
<td>The number of driveways encountered per minute. It equals the total number of driveways along a link divided by the time needed to walk the distance between the first and last driveways along a link.</td>
</tr>
<tr>
<td></td>
<td>To calculate the walking time, it is assumed that driveways are evenly spaced along a link. The distance between two extreme driveways is distance * (n-1) / (n+1), where n is the number of driveways. For example, if a link is 300 feet and has three driveways, then the driveways divide the link into four equal parts of 75 feet. The driveways are 75 feet apart, and the first driveway is 150 feet from the last driveway.</td>
</tr>
<tr>
<td>HAZ_1_WITH</td>
<td>The hazard rating of the link with traffic. It equals the sum of F CONDITIONS, F VOLUME = LOG(V), F SPEED, and F DRIVEWAYS. The higher the rating, the more hazardous.</td>
</tr>
<tr>
<td>HAZ_1_AGNT</td>
<td>The hazard rating of the link against traffic. It equals the sum of F CONDITIONS, F VOLUME = LOG(V), F SPEED, and F DRIVEWAYS. The higher the rating, the more hazardous.</td>
</tr>
<tr>
<td>IMP_WITH</td>
<td>HAZ_1_WITH multiplied by WALK_TIME. For two links with the same HAZ_1_WITH, the longer link will have the higher impedance, because someone walking along the longer link will be exposed to traffic for a longer period of time. Impedance is discussed in more detail in the section on &quot;Impedance.&quot;</td>
</tr>
<tr>
<td>IMP_AGNST</td>
<td>HAZ_1_AGNT multiplied by WALK_TIME. For two links with the same HAZ_1_AGNT, the longer link will have the higher impedance, because someone walking along the longer link will be exposed to traffic for a longer period of time.</td>
</tr>
<tr>
<td>WALK_TIME</td>
<td>The time needed to walk the length of the link, assuming a walking speed of 3.5 feet / second or 210 feet / minute or 2.4 miles / hour.</td>
</tr>
<tr>
<td>FT_CMCOST</td>
<td>The total from-to cost for the segment</td>
</tr>
<tr>
<td>TF_CMCOST</td>
<td>The total to-from cost for the segment</td>
</tr>
</tbody>
</table>

Appendix F: Impedance Methodology

The impedance methodology for this application is based on a methodology developed by Rajeev Karamchedu of CDA Investment Technologies. The impedance indicates how desirable a street is for walking. It is directly proportional to how long it takes to walk the link or crossing,
and the hazard associated with walking the link or crossing. The lower the impedance, the more desirable a link or crossing is for walking.

**Link Impedance**
The impedance of walking along a street (i.e., link impedance) depends on the following factors:

1. Length of the roadway  
2. Hazard associated with sidewalk conditions  
3. Hazard associated with the volume of vehicular traffic during AM and PM school hours  
4. Hazard associated with the speed of the vehicles in the adjacent travel lane  
5. Hazard associated with the number of driveways leading to the sidewalk  
6. Hazard associated with shoulder conditions  
7. Hazard associated with on-street parking  
8. Hazard associated with other contributing factors

The link impedance is expressed as:

$$ I = \left( \frac{L}{(3.5 \times 60)} \right) \times ( f_{sw} + f_{vols} + f_{speeds} + f_d + f_{sh} + f_p ) + N $$

The hazard ratings and the link impedance are different for walking with traffic and walking against traffic.

N refers to other contributing factors that affect the relative desirability of different links. High values of N may be assigned to undesirable links (such as high crime locations) to ensure that they do not appear in the route calculated by the “Safe Route to School” application. Low or even negative values of N may be assigned to desirable links (such as those with sidewalks) to increase the likelihood that they do appear in the calculated route. One example of N is SIDEWALK ADJUSTMENT, which we used to calculate IMPEDANCE #2.

**Crossing Impedance – Signalized Intersections**
In order to calculate the crossing impedance of streets at signalized intersections, the following factors are considered:

1. Width of the crossing  
2. Presence of crosswalk markings  
3. Vehicle speeds at the crossing  
4. Pedestrian signals  
5. Crossing volumes  
6. On-street parking along the street near the  
7. One-way or two-way street  
8. Other contributing factors

The crossing impedance at signalized intersections is expressed as:

$$ I = \left( \frac{W}{(3.5 \times 60)} \right) \times ( f_{cw} + f_{speeds} + f_{pedsig} + \ln(V) + f_p + f_{one-way} ) + N $$

The values of the factors and the crossing impedance are different for crossing one-way and two-way streets.

**Crossing Impedance – Unsignalized Intersections**
The impedance of crossing a street at an unsignalized crossing is determined by the following factors:

1. Width of the crossing
2. Crosswalk markings $f_{cw}$
3. Vehicle speeds at the crossing $f_{speeds}$
4. Crossing volumes $V$
5. On-street parking near the crossing $f_p$
6. One-way or two-way street $f_{one-way}$
7. Available gaps $f_{gaps}$
8. Other contributing factors $N$

The crossing impedance at unsignalized intersections is expressed as:

$$I = (W \times (3.5*60)) \times (f_{cw} + f_{speeds} + f_{gaps} + \ln(V) + f_p + f_{one-way}) + N$$

The values of the factors and the crossing impedance are different for crossing one-way and two-way streets.

**SAFE ROUTE TO SCHOOL HAZARD RATING**

Under the impedance methodology used here, the hazard ratings are on a scale of 1 to 5, where 1 is the least hazardous and 5 is the most hazardous.

The following table provides an example average hazard ratings collected, which would then be used to calculate impedance. These tables are adapted from tables that Rajeev Karamchedu provided.

**The Hazard of Walking along a Street**

<table>
<thead>
<tr>
<th>HAZARD RATING</th>
<th>WALKING CONDITION</th>
<th>F SPEEDS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pedestrian walking on the edge of the travel lane with</td>
<td>With traffic</td>
<td>5.0</td>
</tr>
<tr>
<td>· No sidewalk</td>
<td>Against traffic</td>
<td>4.0</td>
</tr>
<tr>
<td>· No on-street parking</td>
<td></td>
<td></td>
</tr>
<tr>
<td>· No shoulder</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pedestrian walking on the edge of the travel lane with</td>
<td>With traffic</td>
<td>4.6</td>
</tr>
<tr>
<td>· No sidewalk</td>
<td>Against traffic</td>
<td>4.4</td>
</tr>
<tr>
<td>· On-street parking permitted</td>
<td></td>
<td></td>
</tr>
<tr>
<td>· No shoulder</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pedestrian walking on the shoulder with</td>
<td>With traffic</td>
<td>4.2</td>
</tr>
<tr>
<td>· No sidewalk</td>
<td>Against traffic</td>
<td>4.0</td>
</tr>
<tr>
<td>· No on-street parking</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pedestrian walking on the sidewalk with</td>
<td>With traffic</td>
<td>1.6</td>
</tr>
<tr>
<td>· A sidewalk present</td>
<td>Against traffic</td>
<td>1.4</td>
</tr>
<tr>
<td>· No on-street parking</td>
<td></td>
<td></td>
</tr>
<tr>
<td>· No shoulder</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pedestrian walking on the sidewalk with</td>
<td>With traffic</td>
<td>1.6</td>
</tr>
<tr>
<td>· On-street parking permitted</td>
<td>Against traffic</td>
<td>1.2</td>
</tr>
<tr>
<td>· No shoulder</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pedestrian walking on the sidewalk with</td>
<td>With traffic</td>
<td>1.2</td>
</tr>
<tr>
<td>· A shoulder present</td>
<td>Against traffic</td>
<td>1.0</td>
</tr>
<tr>
<td>· No on-street parking</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Speed of vehicles in the travel lane adjacent to the pedestrian</td>
<td></td>
<td></td>
</tr>
<tr>
<td>· 0 - 15 miles / hour</td>
<td>F SPEEDS</td>
<td>1.4</td>
</tr>
<tr>
<td>· 16 - 25 miles / hour</td>
<td>F SPEEDS</td>
<td>1.8</td>
</tr>
<tr>
<td>Speed Range</td>
<td>Value 1</td>
<td>Value 2</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>26 - 35 miles / hour</td>
<td>2.6</td>
<td>2.6</td>
</tr>
<tr>
<td>36 - 45 miles / hour</td>
<td>3.2</td>
<td>3.2</td>
</tr>
<tr>
<td>46 - 55 miles / hour</td>
<td>4.0</td>
<td>4.0</td>
</tr>
</tbody>
</table>